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Overview
The Applicam system is a Computer Aided Manufacturing system (CAM) that takes
the drawing of a component (created as a 2D flat development, either by the internal
Applicam drawing system or an external CAD system) and aids you in the process of
applying appropriate tooling to the component and filling “real world” sheet with
the component (and any companion components) ready for production. The Applicam
system will then turn this tooled, full sheet drawing into an efficient G & M code
program ready to run on your machine (Punch Press, Profiler or combination of
both). Finally the Applicam system will send the program to the machine via an
RS232 cable or put it onto a floppy disk (depending on your machines requirements).

The Applicam system is capable of supporting many different machines in one
installation. The drawings & G & M code programs for each machine are kept
separate and can be further subdivided into directories based on customers or job
type (if your work is mostly in-house).

The picture bellow shows the initial Applicam window (this is what you will be
presented with on first running the Applicam system) from which all the component
sections of the Applicam system are accessed or launched.

Applicam System - Main Window

Menu Structure

Active MachineCurrent Directory
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The standard routine for preparing a job from beginning to end usually involves:

1) Select the machine you wish to run the job on (obviously only applicable if you run
two or more machine from the one Applicam system). “Select Machine” is found
under the “File” menu branch.

2) Create and save (in the correct directory) a tooled drawing of the job in the
Applicam drawing package (either from scratch or starting with an untooled drawing
imported from a CAD system as a DXF file). The drawing package is launched by
clicking on the “Draw” menu item.

3) Fill a usable size sheet with the tooled components required for the job. This is
done in the drawing package or via the optional nesting package.

4) Turn the full sheet drawing into a G & M code program for the selected machine
(“Program” menu item).

5) Send the G & M code program to the machine for execution. This is usually done
via an RS232 cable link using the Applicam communications software
(“Communications” menu item).

You should notice that the menu items for accessing the facilities required in these
tasks (“File”, “Draw”, “Program” & “Communications”) follow the menu structure
from left to right in the order they are needed.

Prior to using the Applicam system you will probably have to give the system some
information about your machine and the way you work. If you have a punch press you
will need to input all your tools into the tool library and maybe you will want to
set-up a list of the materials you work with. These and other set-up options are
accessed via the “Setup” menu branch.

Once your system is set-up (most of which will have been done for you by Applicam
at the time of purchase) working with the Applicam system will mostly involve
learning a routine that best gets your work done.
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File Menu
The “File” menu branch contains the facilities for managing your Applicam
drawings & programs. This includes selecting the machine you are working with
(only applicable in multi-machine systems); creating directories (separately for each
machine); and managing your drawings / programs.

For each job you complete with the Applicam system there will be several files
sharing the same job name. They can be split down into two categories: the drawing
(plus associated files) and the G & M code program. The file handling routines ask
you to choose whether you wish to perform the task in question on the drawing, the
program or both (this is the default).
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Select Active Machine

Clicking the “Select Machine”
menu item (above) will launch the
select machine window (right)
which offers you a list of the other
machines (your current machine is
not listed) that your Applicam
system supports.

Simply highlight the machine you
require and click the “OK”
button.

If successfully completed you
should see confirmation of the
machine change to the right of the
Applicam status bar (bellow).

Active Machine
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Change Current Directory

Clicking the “Change Directory”
menu item (above) will launch the
Change Directory window (right)
which offers you a list of the other
directories (your current directory
is not listed) that have been set up
for the active machine.

Simply highlight the directory you
require and click the “OK” button.

Current Directory

If successfully completed you should see confirmation of the directory change to the
left of the Applicam status bar (bellow).
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Create New Directory
Clicking the “Create Directory”
menu item (top right) will launch
the Create Directory window
(bottom right).

Simply type the name of the new
directory into the text box and click
the “OK” button. In this example
the directory is called “New
Directory”.
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Rename Directory
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Delete Directory
Clicking the “Delete Directory”
menu item (top right) will launch
the Delete Directory window (right)
which offers you a list of the other
directories (your current directory
is not listed as you cannot delete
the current directory - you must
change directory first) that have
been set up for the active machine.

Simply highlight the directory you
wish to delete and click the “OK”
button.

You will be asked to confirm the
deletion and if the directory is not
empty you will be informed of that
fact, warned that all its contents
will be deleted along with the
directory and asked for further
confirmation that you wish to
proceed.

To avoid accidents, you can only
delete one directory at a time.
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File Search
Clicking the “File Search” menu
item (top right) will launch the File
Search window.

Simply type in the text you wish to
search your job names for, tick
whether you are looking for a
drawing, a program or both, then
click the “OK” button.

You will be presented with a list of
all the jobs that contain your
search text in their name along
with the directory each job is in
(bottom).

Selecting a job from this list and
pressing the “OK” button will set
that job as the current job. When
you next go to select a job (be it in
the drawing package or anywhere
else) you will find the job selection
window pointing at this file by
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Delete File(s)
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Rename File As ...
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Copy File As ...
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Move File(s) To ...
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Copy File(s) To ...
Clicking the “Rename Directory”
menu item (top right) will launch
the Rename Directory window
(middle right) which offers you a
list of the other directories (your
current directory is not listed as
you cannot rename the current
directory - you must change
directory first) that have been set
up for the active machine.

Simply highlight the directory you
wish to rename, type its new name
into the text box bellow the
directory list and click the “OK”
button.

You will be asked to confirm the
change before it takes effect
(bottom right).
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Restore Drawing

The “Restore Drawing” facility enables you to recover any drawing you were
working on at the time of a power cut.

On restarting the Applicam system click the “Restore Drawing” menu item (above)
then fill in the drawing name and directory in the Restore Drawing window (bellow).
If the drawing had been saved at least once prior to the power cut you can just select
its name from the pull-down list.

You must NOT go into the Drawing Package before recovering the lost drawing.
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Import File(s)

The “Import File(s)” facility can be used to bring your existing G & M code
programs into the Applicam system.

Simply locate them on your computer / network using the browse lists (Drive, Folder,
File), select the Applicam directory you wish to place them in and click the “OK”
button.

If you have purchased the “Reverse Engineering” option, you could then generate
Applicam drawings from these imported G & M code programs.
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Export File(s)

The “Export File(s)” facility can be used to copy drawings or programs from the
Applicam system to floppy disk (or any where else on your PC / Network).

Your most likely reason for doing this is to transfer programs to a machine that is
not connected via RS232. To aid compatibility in these circumstances you can
change the extension for the program and even force the name to comply with the old
eight character (DOS) filename constraints.

Simply choose whether you wish to export drawings, programs or both; set the
output format (extension, etc.); select the jobs you wish to export; locate the target
drive / folder and press the “OK” button.

The output format you set will be remembered for the next time to export any files.
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Export File As ...

The “Export File As ...” facility does the same job as the “Export File(s)” facility
(see previous page) with the one difference that it allows you to give the exported file
a completely different name. As a result of this you can only export one file at a time
by this method.
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Exit

Clicking the “Exit” menu item (or the standard close window button) will close the
Applicam main window. Any of the other Applicam packages still open will remain
open and functional though we recommend that you shut the main Applicam window
last of all.
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Drawing Package

Clicking the “Draw” menu item will launch the Applicam Drawing Package.

The Applicam Drawing Package looks and behaves differently depending on whether
the active machine is a Punch Press, a Profiler or a combination of both.

Click on the link bellow to see the dedicated manual that is applicable for your
machine.

Punch Press

Profilers
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Nesting

Nesting is an optional extra. It is more appropriate for use with profiling or
combination machines.

Clicking the “Nesting” menu item will launch the Nesting Package.

Click on the link bellow to see the dedicated nesting manual.

Nesting
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Creating a G & M code Program

The process of creating a program differs slightly depending on the machine the
program is being written for.

The following pages contain an example for a typical punch press (programming for
profilers is much the same with just a few tool related steps missed out).

The programing process is started by clicking on the “Program” menu item (above).
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First select the job you wish to program. This first window (above) gives you a pull
down list from which to select the directory you wish to look in and a file list showing
all the drawings in that directory (with accompanying picture to aid identification).

The second program window (bellow) prompts you for any additional information
that is needed in the program. This information is configurable to your requirements.
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The final program window, the “Turret Page”, shows you a list of all the tools used
in the job being programmed and offers you valid stations in which to use them.

Should you wish to avoid changing tool stations you can use a “Standard Turret”.
This is a list of the tools currently in the turret.
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Loading a standard turret will give any of the current tools already in the turret their
correct station numbers. Any tools that need to be loaded will be given the station
number 0 forcing you to allocate them a valid station.



Page 29

When all the used tools have been allocated a station, you can save the turret
changes to your standard turret, ensuring that it is up to date (it should match the
actual tooling on the machine).

Check that the Auto-Reposition facility is switched on if needed (box ticked for on)
then press the “OK” button to proceed with the program creation.



Page 30

Edit Menu

The ”Edit” menu offers you the chance to see your G & M code programs and
change them.

There should be no need to change any of the Applicam system’s G & M code output,
but we offer the facility to do so for the sake of completeness.

Along with standard text editing, there are a couple of automated editing features:
”Renumber Program(s)” enables you to change the programs line numbering
(perhaps necessary after inserting new code); “Strip Numbers” will remove all line
numbers from a program, this can be used as a method of reducing the size of a
program when dealing with machines that have a small program memory. Similarly
stripping all the spaces from a program can save a useful amount of memory.

The Applicam system also generates reports (in a text file format) when it creates a
program, these reports can be viewed and printed via the edit menu.
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Edit Existing Program
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Edit New Program

It is very unlikely that you will want to write a new G & M code program for your
machine, so this facility is perhaps more useful as a method of creating information
files pertaining to the work in a given directory. These files will be saved as
“programs” so you should insure the name you give the accurately reflect their
purpose.
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Renumber Program(s)
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Strip Line Numbers
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Remove Spaces
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View Program Report
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The Program Report can be configured to display whatever information you require.

The report is viewed in the same text editor used for editing programs, so you can
add and save any further information / comments you wish.

Often the report is printed and used as a set-up sheet for the machine operator.
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Communications Menu

The ”Communications” menu offers you the facility to send one or more G & M code
programs to a machine via an RS232 cable and receive programs back from the
machine for archiving (or reverse engineering) in the Applicam system.

A few older machines with Westinghouse Producer controls require different
communications software for loading and unloading the machine “Executive”
program. If your machine is one of these you will see “Send Executive” and “Receive
Executive” added to the communications menu when that machine is selected. On
installing the Applicam software you should take the time to “Receive” the executive
from your machine as soon as possible thereby saving a copy of it on your PC for
future use.
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Send Program

Clicking the “Send Program” menu item will launch the Send program window.

This window offers you a pull-down directory list and accompanying file list showing
all the G & M code programs in the selected directory.

You select programs from the file list by highlighting them and clicking the “Add”
button, this will add the highlighted program to the send list to the right of the
window. You can add as many programs as you wish to the send list and (with the use
of the pull-down directory list) the can be from several different directories.

Once you have compiled the send list press the “OK” button, you should be able to
call the programs from your machine and they will be sent in the same order as the
send list.
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Receive Program

Clicking the “Receive Program” menu item will launch the Receive program
window.

This window offers you a text box for inputting the name of the file you intend to
receive from your machine and a pull-down directory list for selecting which of your
directories you want the program saved to.

Once you have inputted a name and selected the directory press the “OK” button,
you should then be able to send the program from your machine and see it being
received by the Applicam system.
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Send Executive

Having selected the Executive to
send and pressed the “OK” button
the Applicam communications
software will be waiting for the
Westinghouse to ask for the
Executive.

To call an Executive into the
Westinghouse Producer follow there
steps:
At the machine, press E-Stop to
disable the machine.
Now press and hold
ALTER-FUNCTION, TEST2 AND 2
simultaneously.
The controller should then read the
executive program.
The hexadecimal address shown on
the Westinghouse screen should
update regularly as a sign of
loading.
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Receive Executive

At the Westinghouse Producer
control, press E-Stop
Now press Keyboard Seize
Type in HM,F,FFFF and press
Enter Data
Now press Keyboard Seize
Type in HM,16A9,0000 and press
Enter Data
Now press Keyboard Seize
Type in RM and press Enter Data

If the executive memory cannot be unlocked using the above method, go into the
Maintenance page and choose Addresses. Look at Address 22. This will show a
Hexadecimal number. If it is not 16A9 as above, retry again but substitute 16A9 with
the value shown at address 22.
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Communications Settings

Clicking the “CNC Communications” setup menu item will launch the
communications data file into your chosen text editor (notepad is the default).
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FANUC 25 pin Male   PC 25 pin Female

TXD  2 ----------- 3 RXD
RXD  3 ----------- 2 TXD
RTS  4 ----------- 5 CTS
CTS  5 ----------- 4 RTS
DSR,DCD  6,8 ----------- 20 DTR
GND  7 ----------- 7 GND
DTR  20 ----------- 6,8 DSR,DCD
SCREEN   ----------- 1 FRAME

Cable Pin-Outs
FAGOR 9 pin Male   PC 25 pin Female

TXD  2 ----------- 3 RXD
RXD  3 ----------- 2 TXD
RTS  4 ----------- 5 CTS
CTS  5 ----------- 4 RTS
DSR,DCD  6,8 ----------- 20 DTR
GND  7 ----------- 7 GND
SCREEN   ----------- 1 FRAME

GE2000P 25 pin Male  PC 25 pin Female

TXD  2 ----------- 3 RXD
RXD  3 ----------- 2 TXD
RTS  4 ----------- 5 CTS
CTS  5 ----------- 4 RTS
DSR,DCD  6,8 ----------- 20 DTR
GND  7 ----------- 7 GND
DTR  20 ----------- 6,8 DSR,DCD
SCREEN   ----------- 1 FRAME

WESTINGHOUSE MDI  PC 25 pin Female
ZSC SOCKET
TXD  A6 ----------- 3 RXD
RXD  A19 ----------- 2 TXD
RTS  B6 ----------- 5 CTS
CTS  A22 ----------- 4 RTS
DTR  A8 ----------- 6 DSR
DSR  B19 ----------- 20 DTR
GND  B1 ----------- 7 GND
SCREEN   ----------- 1 FRAME

WESTINGHOUSE PRODUCER  PC 25 pin Female
25 pin Female
TXD  2 ----------- 2 TXD
RXD  3 ----------- 3 RXD
GND  7 ----------- 7 GND
SCREEN   ----------- 1 FRAME

NUM 25 pin Male   PC 25 pin Female

TXD  2 ----------- 3 RXD
RXD  3 ----------- 2 TXD
RTS  4 ----------- 5 CTS
CTS  5 ----------- 4 RTS
DSR,DCD  6,8 ----------- 20 DTR
GND  7 ----------- 7 GND
DTR  20 ----------- 6,8 DSR,DCD
SCREEN   ----------- 1 FRAME

DYNAPATH 25 pin Male  PC 25 pin Female

TXD  2 ----------- 2 TXD
RXD  3 ----------- 3 RXD
RTS  4 ----------- 4 RTS
CTS  5 ----------- 5 CTS
DSR,DCD  6,8 ----------- 6,8 DSR,DCD
GND  7 ----------- 7 GND
DTR  20 ----------- 20 DTR
SCREEN   ----------- 1 FRAME

TRUMPF    PC 25 pin Female

TXD  A6 ----------- 3 RXD
RXD  A19 ----------- 2 TXD
RTS  B6 ----------- 5 CTS
CTS  B22 ----------- 4 RTS
CTS  A22 ----------- 4 RTS
GND  B1 ----------- 7 GND
SCREEN   ----------- 1 FRAME

9 pin Female  PC 25 pin Female
TXD  3 ----------- 2 TXD
RXD  2 ----------- 3 RXD
RTS  7 ----------- 4 RTS
CTS  8 ----------- 5 CTS
DSR  6 ----------- 6 DSR
GND  5 ----------- 7 GND
DCD  1 ----------- 8 DCD
DTR  4 ----------- 20 DTR
SCREEN   ----------- 1 FRAME
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Reverse Engineering

Reverse Engineering is an optional extra. It enables you to create Applicam drawings
from any hand written G & M code programs you might have written prior to buying
the Applicam system.

Clicking the “Reverse” menu item will launch the Reverse Engineering Package.

Click on the link bellow to see the dedicated reverse engineering manual.

Reverse Engineering
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Setup Menu

The “Setup” menu is where you will find all the components of the Applicam system
that customise it to your machine and working practices.
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Tool Library

The tool library is where you tell the Applicam system about the tooling you have for
your Punch Press and is therefore only applicable to punch presses and punch press
combination machines.

Clicking the “Tool Library” menu item will launch the Tool Library.

Click on the link bellow to see the dedicated Tool Library manual.

Tool Library
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Material Database

Most modern machines (and all profilers) have settings that can be changes to
optimise the machines performance with different materials. The Applicam Material
Database (along with its related punch / profile settings manager) is where the
information allowing the Applicam system to make full use of your machine’s
capabilities is entered.

Clicking the “Material Database” menu item will launch the Material Database.

Click on the link bellow to see the dedicated Material Database manual.

Material Database
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Profile Settings

Where the Material Database stores standard settings for different specific materials,
the Profile Settings package allows you to store settings changes for differing cut
conditions within a job. For example you might have stored settings for engraving as
opposed to cutting all the way through a sheet.

Clicking the “Profile Settings” menu item will launch the Profile Settings manager.

Click on the link bellow to see the dedicated Material Database manual.

Profile Settings
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Stock Manager

The Stock Manager allows you to tell the Applicam system what size sheets of each
material (and quantities) you have in stock.

Clicking the “Stock Manager” menu item will launch the Stock Manager.

Click on the link bellow to see the dedicated Stock Manager manual.

Stock Manager
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Shapes & Tooling

The “Shapes & Tooling” manager allows you to keep control of any Custom Shapes
or Associative Tooling options that you have created in the drawing package.

Clicking the “Shapes & Tooling” menu item will launch the Shapes & Tooling
manager.

Click on the link bellow to see the dedicated Shapes & Tooling manual.

Shapes & Tooling
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Edit Data Files

The data files that customise the Applicam system for your machine should be set
correctly at the time of installation. Any changes to these files can cause the system to
operate incorrectly therefore no alterations should be undertaken without consulting
Applicam.
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Restore Defaults

Should the Applicam data files become corrupted you cam retrieve a set of files saved
at the time of installation by clicking the “Restore Data Files” menu item. Unless you
know for certain that these are a fully working set of file you would be advised to
contact Applicam prior to taking the “last resort” action.
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Export System Setup

Should you suffer any problems with the Applicam system we may ask you to send
your data files to us to help with finding the problem.

The “Export System Setup” facility will copy all your data files onto a floppy disk.
This disk can then be posted to Applicam or the contents e-mailed to Applicam
(Applicam@aol.com).
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Contact Applicam

Applicam Ltd

3 Crown Close
Hail Weston

St. Neots
Cambridgeshire

PE19 5LE
UK

Tel: 01480 213 025
Fax: 01480 407 201

Email: Applicam@aol.com
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Links To Other Manuals

Drawing Package - Punch Press

Drawing Package - Profiler

Nesting Package

Reverse Engineering

Tool Library

Material Database

Stock Manager

Shapes & Tooling
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